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  IPL = Initial Program Load 
 

 

Device description WRKDEVD *ALL Work with device description 
 

 

Run DAY1, SYSDAT, & SYSDATE WRKJOBSCDE Go into job scheduler and rerun DAY1, 
SYSDAT, and SYSDATE (enter a 10 to run 
immediately) 

If you get an error message for SYSDAT, 
SYSDAT2, or DAY1CL you can cancel 
them (take a C for the message)  then 
rerun DAY1, SYSDAT, and SYSDATE 
 

Start GUI License Manager SEALMS/STRLMSTCP Start GUI License Manager from command 
line 

After starting SANDIS, user gets error 
about license manager not being started. 
Users do not get GUI screen in SANDIS. 
 

Start Print Writer STRPRTWTR Starts the writer for a remote out queue 
 

 

Start Remote Writer STRRMTWTR Start remote writers When no writer shows up when a 
WRKOUTQ is entered, run this 
command to start writer for the queue. 
 

Tape backup schedule WRKJOBSCDE Backups are QEZBKSNxxx (xxx=day) 
 

 

Vary on command WRKCFGSTS *DEV For devices 
 

 

Work with active jobs WRKACTJOB 
 

  

Work with output queue WRKOUTQ Checks status of output queues 
 

 

Work with print writers WRKWTR *ALL Looks at  (remote) writers 
 

 

Work with printers WRKWTR Looks at printers 
 

 

Work with spool file WRKSPLF This will display the user’s spool file. 
 

 

Work with user profiles WRKUSRPRF *ALL Modify user accounts. Replace *all with user 
name or use wild card, i.e.: rcdb* 
 

 

    
 



i5 Security 
 
 
System Security Level 40:  

• User must sign on with valid ID and password. 
• Users have access to objects only when the objects are designated as usable by the individual user or 

by *PUBLIC (anyone). 
• When restoring files the system defaults to “Allow Object Differences” set to No.  This will not allow 

an older file to overwrite the same file on the system if the system file has been changed since the old 
one was backed up.  The “Allow Object Differences” parameter can be manually set to Yes if you 
want to allow the overwrite. 

 
 
User Passwords: 

Suggested password settings are: 
Minimum of 6 characters max of 10. 
Allowable characters are A-Z, 0-9, and characters dollar ($), at (@), number (#), and underscore (_). 
Characters can not be used consecutively. 
Passwords Expire after 90 days. 

 Users can not reuse any of their previous 12 passwords. 
 
 
Common System Accounts:  (these might be used in the individual user profiles under “User class”) 
 
QSECOFR  - Security Officer 

Can do anything on the system except service functions (Service functions are generally given only to 
very experienced users or your IBM vendor). 
This should only be given to one or two staff in a company. 

 
QSYSOPR - System Operator  

Authority to control jobs, print files, and do backup and restore functions. 
 

QUSER – User 
System supplied user profile. 
Everyone outside of the computer department should be a User. 

 
NOTE:  For staff needing access to specific system functions use the following as a 
guideline.  Grant only the minimum access required by the user. 
 
Special Authorities 
*NONE 

No special authorities are assigned to the user. 
 
*ALLOBJ 

The user can do anything to any object and overrides any public or private authorities on the system. 
This should be reserved for the SECOFR, the MIS Manager, and the Computer Operator only. 
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*AUDIT 
The user can change system values that control Auditing. 
This should be reserved for the MIS Manager and the Computer Operator only. 
 

*IOSYSCFG 
The user can change system configurations for network, communications device, controllers, lines, 
TCP/IP server. 
This should be reserved for the MIS Manager and the Computer Operator only. 

 
*JOBCTL 

User can manage jobs running on the system including those belonging to other users or to the 
system. 
These are typical authorities granted to the computer/system operator. 
The user can: 

Display, hold, release, or cancel jobs. 
Change output to other queues. 
Change job priorities. 
Start/stop printers. 
Start/stop entire subsystems. 
Load the operating system. 
Etc. 

 
*SAVSYS 

The user can perform backup and restore operations on all objects even if the user does not have 
authority to the object.  User can save, restore, or free storage for all objects. 
This is typically granted to the computer/system operator. 
 
 

*SECADM 
User can create and change user profiles. Note. This can only be granted by a user who already has 
both *SECADM and *ALLOBJ authority. 
This should be reserved for staff that must create and maintain user profiles. 
 

*SERVICE 
User can run service functions on the i5 like s System Service Tools. 
This should be reserved for IT staff that are very knowledgeable about the system.  May be reserved 
exclusively for IBM Business Partner or DDS Technical staff. 
 

*SPLCTL 
The user can manage spool files, display, release, print, move, and cancel spooled output. 
The user can access anyone’s spooled output so should not be granted unless necessary. 
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User Class 
 
This is used to quickly specify the special authorities for a user.  Additional authorities can still be granted in 
the Special Authorities section of the profile 
 

Special Authorities Granted to “User Class” for System Security Level 40 
User Class *ALLOBJ *AUDIT *SECADM *SAVSYS *JOBCTL *SPLCTL *SERVICE
*SECOFR X X X X X X X 
*SECADM   X X X   
*PGMR    X X   
*SYSOPR    X X   
*USER No Special Authorities for “User” 
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Settings for i5 Accounts 
 
 

 
 
User Profile:   

User’s Account name. 
 
User password: 

Suggested password settings are: 
Minimum of 6 characters max of 10. 
Allowable characters are A-Z, 0-9, and characters dollar ($), at (@), number (#), and underscore (_). 
Characters can not be used consecutively. 
Passwords Expire after 90 days. 
Users can not reuse any of their previous 12 passwords. 

 
Set password to expired: 

No – Password is currently active and can be used. 
Yes – Password has expired and needs to be changed.   
You can force a user to create a new password next time they log on by setting this to Yes. 

 
Status: 

Enabled – Account is enabled and useable. 
Disabled – Account has been locked (generally from too many incorrect password attempts). 
You can manually disable an account by setting this to Disabled. 
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User class: 
This is used to quickly grant special authorities for a user.  Individually authorities can be granted 
using the Special Authorities section of the profile. 

 
Special Authorities Granted to “User Class” for System Security Level 40 

User Class *ALLOBJ *AUDIT *SECADM *SAVSYS *JOBCTL *SPLCTL *SERVICE
*SECOFR X X X X X X X 
*SECADM   X X X   
*PGMR    X X   
*SYSOPR    X X   
*USER No Special Authorities for “User” 
 
 
Assistance level: 

*BASIC – This is best for new or occasional users.  The Operational Assistant is used to provide 
step-by-step help. 
 
*INTERMEDIATE – This is the default value and provides complete information.  All options are 
available and displayed. 
 
*ADVANCED – This is only for very experienced users and probably not suitable for Regional 
Center Staff.  All options are available but some options might not be displayed in order to make 
room for more information.  Option keys and Function keys are not displayed. 

 
 
Initial program to call: 

Use this to “call” (run) a program when the user logs on.   
Some regional centers use this to start a program called JSATARTCL1 in the SAND400 library. 

 
Initial menu: 

Use this to specify the menu the user will have when they log on. 
 
Limit Capabilities: 

Use this to restrict a user’s ability to execute commands from a command line. 
 
*NO – Users can run commands and can change their menu, program, and library values. 
This setting is not recommended for most staff. 
 
*PARTIAL - Users can run commands and can change their menu but not the program or library 
values. 
Users that need to use command line commands should have this setting. 
 
*YES – Users can not run commands nor change their menu, program or library values. 
Staff should have this setting unless they need to use command line commands. 

 
Text ‘description’: 

This is the display name and should include the user’s name and pertinent information. 
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Page 2 of the Profile - Additional Parameters: 
 
To access page 2, press the Advanced Key in the window or the F10 Key.  Then press the down arrow on the 
screen or page down on the keyboard. 
 
 
Most of these fields will be left at the default values displayed in the image below. 
 

 
 
 
 
Special authority: 

Special Authority should be set to *NONE. 
 

 
If access to specific system functions is required for a particular user they can be granted Special 
Authority by removing *NONE from Special authority section then specifying other options.  Before 
setting anything other then *NONE see the information in “Special Authorities” and “User Class” at 
the beginning of this document.  Only grant the minimum authority required for their job. 
 
To add more than two special authorities, click the “+” sign next to the last special authority.  
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Page 3 of the Profile: 
 
The Message queue will be assigned automatically. 
Print Device, Output Queue and Library should be configured according to Regional Center procedures for 
printers. 
All other fields will be left at the default values displayed below. 
 

 
 
 
Page 4 of the Profile: 
 
The User ID number will be automatically assigned by the system and should not be changed. 
All other fields will be left at the default values displayed below. 
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Page 5 of the Profile: 
 
All fields will be left at the default values displayed below. 
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SANDIS Security 
 
SANDIS security configurations are additional security measures which are built into and apply to SANDIS 
and UFS applications only. 
 
User accounts  
User account names are created using the following guidelines. 

First two characters = Regional Center (i.e. “AL” for Alta) 
Third and fourth characters = Unit Code (M0, Z0, J0, etc.) 
Fifth character = Unique identifier for each user in a particular unit (0, 1, 2, 3 …..A, B, C, etc.) 
Remaining characters = First four characters of users first name (If under four, start using last name) 

 
SANDIS Table of Codes  
The SANDIS Table of Codes should be used to grant appropriate security within the SANDIS/UFS system. 
 
Personal Codes 

Menu – SANDIS Processing 
Menu – Maintain Data Base Tables 
Menu – Update Personal Codes 

 
 

Code:  Unit Code and user unique identifier (M06, Z04, J0B, etc.)  
 

Note: Unit codes “DB” and “AA” have special meaning in SANDIS. 
DB (SANDIS Data Base unit) = Access or Delete all SANDIS records.  This includes 
non-consumer and non-resource records. 
 
AA (Administration unit) = Access to all SANDIS records active and closed.   
This includes non-consumer and non-resource records.  Can not delete records. 
 

Description: User’s name and any descriptive text. 
 
Email address: User’s full email address (name@altaregional.org). 
 
Field X:   SC = Service Coordinator 

     PM = Supervisor 
     Blank = User can’t write ID notes 
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Flag A:   A = All SANDIS records active and closed (including non consumer and resource records). 
    B = All client and resource records 
    C = All client records only 
    I = Inter-regional center transfers 
    R = All resource records only 
    N = Non Regional Center Caseloads (like genetics) 
 

Flag B:    T = Allows global (cross unit) Title-19 access 
 

Flag C:    C = Caseload carrier (Service Coordinator) allows user to enter and update consumer 
records 
 
Flag D:    Y = Title 19 qualifier (can get credit for entering Title 19 units) 
 
Flag GL#:  Not used 
 
Guideline for setting flags: 

Supervisor:  PM     T C Y 
Service Coordinators:  SC     T C Y 
Service Coordinators (no title 19):  SC     T C _ 
Secretaries who enter notes for Service Coordinators:  SC     T C _ 

 
Phone:    (Informational only)  The user’s phone number. 
 
Secretary:    (Informational only)  The user’s secretary’s SANDIS code. 
 

 
Table of Codes 

 
Menu – SANDIS Processing 
Menu – Maintain Data Base Tables 
Menu – Enter/Update Table of Codes 
Enter “UNIT” in the “Field” field and press Enter. 

 
 
Code: Two character Unit Code (M0, Z0, J0, etc.)  
 
Description: Unit name and any descriptive text. 
 
Status:  Not used 
 
Field X:  Not used 
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Field Y:  Not used 
 
Flag A:   Not used 
 
Flag B:    Not used 

 
Flag C:    H = Allows this code to be displayed in the Help screens 

 
Flag D:   Not used 
 
Flag GL#:  Not used 
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Add Library to User’s Library Path 
 

 
 
 
Take Option 2 Work with objects 
 

 
 
Press Enter 
 

 
 
For Position to enter u 
For Position to type enter *jobd  (job description) 
 

 
 
Press Enter 
 
 
On UFSNTV take option 2 (change) 



 
 
Press Enter 
 

 
 
Press F10 for Additional parameters, then  
Scroll down to the Library List 
 
 



 
 
Type a + and space through the last entry to add a library to the bottom of the library list 
 

 
 
 
 



Adding TCP-IP Routes to the i5 
 
Open System i Navigator 
Expand Network and TCP/IP Network, then click Routes 

 
 
 
Click on New Local Area Network (LAN) interface 

 
 
 
Click Next at the bottom of the first window. 

 
 



Select Ethernet and click Next 

 
 
Select List by Lines then select Ehternet1.   
Click Next 

 
 
Enter information for the new route.  Depending on how the system is configured the Network name could be an IP 
address or something line ALR400 

 
 
 
Enter the default gateway for the new route.  This is the gateway on your LAN (probably the same address used for 
Windows servers and other devices connected to the LAN). 
Click Add. 



 
 
Accept the defaults on the next window. 

 
 
Select Yes to start every time and to start now. 

 
 



 
 

 



ADD TCP/IP ROUTE 
 
On the command line enter cfgtcp 
Press Enter 

 
 
On the command line enter 2 Work with TCP/IP routes 
Press Enter 

 
 
Take option 1 to add, key in IP, Subnet, Next Hop 
Press Enter 

 
 

 



 
 
View the Configuration of a Controller 
 
 
On the command line enter WRKLIND ETH* 
Take Option 8 Work with status for the line you want to work with. 

 
 
 
On the first line take Option 8 Work with description. 

 
 
Take Option 5 Display 

 
 



Edit the Configuration of a Controller 
 
You must first end the interfaces associated with the line (Ethernet controller) then vary it off. 
You can then edit the configuration and then vary it on. 
Once it’s on you need to restart the interfaces. 
 
On the Command Line enter NETSTAT 
Option 1 Work with IPv4 interface status 
 

 
 
End the Interfaces associated with the Line Description: 
Take Option 10 on the appropriate addresses.  (If option 10 isn’t present the account you logged on with does not have 
full permissions to the system) 

 
Press F12 to get back to a command line. 
 
Vary off the Controller: 
On the command line enter WRKLIND ETH* 
Take Option 8 Work with status for the line you want to work with. 

 
 
 
Take Option 2 on the first line to vary it off. 
Wait for it to show it’s ended. 

 



 
Press F12 to return to the previous screen (or on the command line enter WRKLIND ETH*) 
Take Option 8 Work with status for the line you want to work with. 

 
 
 
Take Option 8 Work with description on the first line. 

 
 
 
Take Option 2 Change 

 
 
Edit the configuration as necessary. 
Press Enter 
 
 
Vary the controller back on 
 
Restart the interfaces. 



 
Procedure for setting up Printer Output from the System i 

Navigator 
(Enables user to print reports from here or export to a file) 

 
Launch System i Navigator: 

 
 
Note:  You may be prompted to login 
 
Expand the IP Address of the i5 (in this case, 10.96.69.74) 

 
 
Expand “Basic Operations”  

 



 
Right click on “Printer Output” to create a shortcut 

 
 
 
 
 
Click “Printer Output” and right click on the report that you would like to export. 

 
 
Select Export to create a .txt file. Type the name of the report and the extension that you would 
like to export it to.  It will automatically default to a .txt file extension.  Click on Save. 
 

 
 



To copy a spool file to a disk file 
 
First get information about the spool file 
 
go to the output queue  In this case the archive queue. 

 
 
 
Take an 8 to display details  

 
 

 
 

 
 

 
 
 
Copy the file to tape: 
savobj then F4 



 
 
Enter the following information and press enter.  May need to press enter twice. 

 
 
 
Take a 4 to delete the spool file 

 
 
Clear the Reports file (don’t delete it) 

 
 
 
 
 
 
 
Display tape: 
f4 

 
 

 



 
 
 
 
Restore from tape: 
 
rstobj <F4> 

 
 
 
Press F10 for more information 

 
 
 
 
Page Down and change Restore to Library to qtemp 
Note;  This will only be viewable from this session and will be deleted when you sign off. 



 
 
To view the file 

 
 

 
 
Enter again 

 
Use page up / down or f19 or F20 to move around  
 
in control line can put 
B to go to bottom 
T to go to the top 
Pxxx to go to a page number 
Wxx to go to a left right position number. 
 



 



Copy Files to Another Library 
 
On the command line enter CPYF and press F4 

• From file and Library: Enter the file name and the library it’s in. 
• To file and Library: Enter the file name and the library you want to copy it to. 

 

 
 
If the To file already exists and you want to replace it, enter *REPLACE for Replace or add 
records. 
If the To file already exists and you want to append to it, enter *ADD for Replace or add 
records. 
If the To file does not exist, enter *YES for Create file. 



Daily Check of Previous Night’s Backup 
 

UTL007BCL is part of the enhanced back up process created by SANDIS.  It tells you if there 
were things on your system that were not saved.  To see what was not saved, type CALL 
MORNING  (and press Enter).  This will bring up system operator messages for you to view, UFS 
Program Update messages, SANDIS Program Update messages, and your own messages (just 
press ENTER after you're through looking at the messages in each queue).  After that, a menu 
will appear which you can use to look at the back up status for the past few weeks; use option 1 
to select the back up you want to check.   

 
 

 
 

 
When you’re finished, exit the menu and the program will print a display-tape and eject the tape 
for you.   



Daily check for System Messages 
 
Log on as SYSOPR user type 
 
SYOPMAIN Menu: 
Take a 1 for “Display System Message Queue” 

 
 
Scroll up to read the messages and take appropriate action. 

 

  



Initialize Tape (INZTAP) 
                                                                                
Type choices, press Enter.                                                      
                                                                                
Device . . . . . . . . . . . . .     TAP01          Name                           
New volume identifier  . . . . .    HQV006         Character value, *NONE...      
New owner identifier . . . . . .    HQDDS                                        
Volume identifier  . . . . . . .     *MOUNTED Character value, *MOUNTED      
Check for active files . . . . .     *NO            *YES, *NO, *FIRST              
Tape density . . . . . . . . . .     *ULTRIUM3 *DEVTYPE, *CTGTYPE, …. 
Code . . . . . . . . . . . . . .     *EBCDIC        *EBCDIC, *ASCII                
End of tape option . . . . . . .     *REWIND     *REWIND, *UNLOAD               
Clear  . . . . . . . . . . . . .     *NO            *NO, *YES                      
 
Check for active files: 
Specifies whether a labeled tape volume should be checked for active data files before it is 
initialized for use.  If an unlabeled volume is placed in the specified device, this parameter is 
ignored.                                                                                       
*YES                                                      
All data file labels on the tape are checked.  If any active files are found, the operation is ended 
and an error message is sent.                                 
 *NO                                                        
Tape initialization continues with no checking for active files.  To initialize a new or empty volume 
for use, *NO must be specified here and *MOUNTED must be specified on the Volume identifier 
prompt (VOL parameter).                                            
 *FIRST                                                     
Only the first data file label on the tape is checked.  If there are no data files on the volume or if 
the first data file has expired, the volume is initialized for use without checking for any other files 
on the tape.  If the first data file has not expired, the operation is ended and an error message is 
sent.  
 
Clear: 
Specifies whether all previous labels and data are deleted from the tape when it is initialized.  If 
the volume must be cleared of all data, it is spaced from the location of  
the initializing volume label or tape markers to the end of the tape marker. 
 
After you are done do dsptap tap01: 
 
                             Display Tape Volume Information                    
                                                                           
 Device . . . . . . :   TAP01             Volume ID  . . . . :   HQV006    
 Owner ID . . . . . :   HQDDS             Density  . . . . . :   *ULTRIUM3 
 Type . . . . . . . :   *SL               Code . . . . . . . :   *EBCDIC  
*It is important that type is *SL (standard label)                            



Display (Catalog) Tapes 
 
To determine the tape device you want to look at, on a command line enter 
WRKDEVD *TAP and press Enter 
F14 to show device status: 

 
 
On a command line enter 
DSPTAP   then press F4 
 
Data type: 
*LABELS – displays the name of the libraries on the tape.  Does not show files in the libraries. 
*SAVRST – displays each file 
 
Output: 

 = Display  (Note:  libraries are listed one at a time and you must press enter to view the next library.) 

   = Sends the output to your default Spool File 
 



 
 
 



 
TechTip: Download Physical Files Using Microsoft Excel    

Tips & Techniques - Microsoft 
Written by Paul Weyer     
Thursday, 02 September 2004 18:00  
 
Use iSeries Access for Windows to transfer iSeries physical file data into an 
Excel spreadsheet. 

Many end users of iSeries applications need specific data to analyze their 
business, and they require different views of this data. The development staff 
often provides these views in the form of reports either by creating a high-level 
language program (RPG or COBOL) or by writing a query.  
 
iSeries shops have given end users the ability to write their own queries via 
either the standard OS/400 commands or third-party software products. 
However, some of the sequences that the users choose can have a detrimental 
effect on system performance. 
 
Furthermore, one limitation of both the application programs and the query 
options is that a new program or query must be written for every different view of 
the data. Wouldn't it be nice if there were a tool that would allow the end user to 
sequence and group the data without having to write and run individual programs 
and/or queries? Well, there is! That tool is Microsoft Excel. Once data is 
transferred into an Excel spreadsheet, sort and hide functions can manipulate 
that data. Also, transferring the data to a PC eliminates the potential for 
performance degradation on the iSeries. 
 
Here's how to use the iSeries data transfer function: 

1. Open Microsoft Excel. 
2. Click on the Data option in the toolbar. 
3. Click on the double arrow to expand the option list. 
4. Look for Transfer Data from iSeries. 

If you see the Transfer Data from iSeries option, the capability to perform data 
transfer is available. If you don't see the option, confirm that IBM iSeries Access 
for Windows (V5R1 and later) or Client Access (prior to V5R1) is installed. If it is 
not installed, install it.  
 
Now, enable the add-in: 

1. Click on the Add-Ins option. 
2. Scan the Add-Ins list for the iSeries Access Data Transfer option.  
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3. Click on the box to enable it. 

If you don't see the iSeries Access Data Transfer option, click the Browse button. 
Using the Look in box, navigate to c:/program files/ibm/client access/shared/ and
select file cwbtfxla.xll. 
 
Now, it's time to perform the data transfer: 

1. Open Microsoft Excel. 
2. Click on the Tools option in the toolbar. 
3. Click on the iSeries Access Data Transfer option. If the iSeries Access 

Data Transfer option is not displayed, click on the double arrow. 
4. A Transfer Data window will open. 
5. Select Create New and choose whether to include column headings. 
6. Click the OK button. 
7. Select the iSeries server the data is to be downloaded from and click the 

Next button. 
8. If you know the library/file (member), type it in and click the Next button; 

otherwise, click the Browse button. If you click the Browse button, a new 
window to connect to the iSeries may be displayed. If so, type in the user 
ID and password. A list of libraries in the library list is displayed. Click on 
the plus sign (+) next to the library where the file exists. The list expands 
to show all the files in that library. If the file contains members, the list 
expands to display the list of members. Double-click on the member that is 
to have the data transferred to the Excel spreadsheet, and click on the OK 
button. Click the Next button. 

9. On the next screen, click the Next button. 
10. If this transfer request will be used again, type in a file name and location 

to where it is to be saved; otherwise, leave the File name box empty. 
11. Click the Finish button. 

 
The data transfer function has now populated the Excel spreadsheet with the file 
records. 
 
There is a limitation of a maximum of 65,535 records that can be transferred from 
an iSeries physical file to an Excel spreadsheet.  
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Download i5 user Profiles 
 
On the command line enter DSPUSRPRF   (display user profile). And press F4 

 
 
User profile: *ALL 
Output: *OUTFILE 
Click OK or press Enter 

 
 
File to receive output: Whatever you want to name the file (example: Profiles) 
Library: enter the library name on the i5 where the file will be saved.  (example: ALTA 
Click OK or press Enter 

 
 
Create an ODBC connection to the i5 library you used 
Open Microsoft Access and download the file. 
 
 
Profiles table field list 

Field Description Notes 
UPDCEN   
UPDDAT Date last updated Sets it to today’s date so not useful 
UPDTIN Time last updated Sets it to today’s date so not useful 
UPSYST  ALR400 
UPUPRF User ID User account 
UPUSCL User class User, secofr, etc 
UPDSIN Assistance level  
UPPWCC Password?? everyone at “1” 
UPPWCD Password changed date  
UPPWCT Password changed time  
PUPWEI Password?? everyone at “0” 
UPPWEX Password expired Everyone at *NO 
UPPWON   
UPPSOC   
UPPSOD ?? changed date  
UPPSOT ?? changed time  
UPDVS   
UPSPAU Special Authority *ALLOBJ, *CHGJOB, *SPPLF, etc. 
UPMXST   
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YPMXSU Maximum allowed storage Most set at 12 
UPPRLT Highest schedule priority Most set at 3 
UPINPG Initial program to call  
UPINDL Initial program to call - Library  
UPJBDS Job description  
UPJBDL Job description - Library  
UPOWNR Group profile - Owner  
UPGRPF Group profile  
UPGRAU Group authority  
UPGRPI   
UPACCD   
UPMGQU Message queue  
UPMGQL Message queue - Library  
UPMGQL   
UPOTQU Output Queue  
UPOTQL Output Queue - Library  
UPTEXT Text ‘description’ User name 
UPSPEN  *NONE 
UPCRLB Current library  
UPINMEN Initial Menu  
UPINML Initial Menu - Library  
UPLTCP Limit capabilities  
UPDLVY Delivery  
UPSVRT   
UPPRDV Print device  
UPATPG Attention program  
UPATPL Attention program - Library  
UPUSOP User options  
UPUPLK   
UPUPDM   
UPSTAT Status Same, *enabled, *disabled 
UPKBDB Keyboard buffering  
UPASTL Assistance level  
UPLANG Language ID  
UPCNTR Country or region ID  
UPCCSI Code character set ID  
UPSRT Sort sequence  
UPSRTL Sort sequence - Library  
UPOBJA   
UPAUDL   
UPGATY   
UPSUPG   
UPUID User ID number  
UPGID Group ID number  
UPSETJ   
UPCHID   
UPENPW   
UPENPH   
UPENLM   
UPLPWM   

 



 

OTech / Statewide Communication Down 
 
There are two controllers in the i5 that handle traffic via OTech (DDS, SANDIS, statewide search, etc.): 

 
DTSAPPC Used for pass through and file transfers. 
DTSHOST Used for statewide search (connection to the statewide database). 

 
 
Check Controller Status: 
 
On the command line enter:  WRKCFGSTS *CTL DTS*  (work with configuration status)  
 
 
Recovery Process: 
 
If either controller is not showing “Varied On” you must vary off each controller. 

Take option 2 (Vary off) on each controller.  Both must be off before proceeding. 
 
Take option 1 (Vary on) to vary on the controllers in the following order: 
  

DTSAPPC (must be varied on first) 
DTSHOST 
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Full System Backup 
 
Note: if at any time you get an error message, place your cursor on the error message and press F1 to 
get a list of the options and codes. 
 
INITIALIZE TAPE 

1. Log on as user with SYSOPR authority 
2. Insert blank tape (any data on tape will be erased) 
3. Type this command: inztap (don’t press enter) 
4. Press f4 and enter the following information: 

 Device = tap01 (or your default tape device) 

 New Volume Identifier = enter name of tape (i.e. Full Backup or State Claims) 

 Check for active files = *no 

 End of tape option = unload 
5. Press Enter 
6. You will get a message that the system is initializing the tape 

 
PRE-BACKUP CHECK – best practices 

1. Enter command: wrkactjob 
2. Press enter 
3. Make sure there are no active jobs and no users are signed on 
4. If they are, they will be disconnected when the backup begins 
5. Make sure you’re logged on as user with SYSOPR authority 
6. From the SYOPMAIN menu type option 1 (Display system message queue) 
7. Press enter 
8. The display lists all messages and errors 
9. Check printer messages and answer each one (Cancel writers that only have option to retry or 

cancel) 
 
BACKUP 

1. Log on as QSECOFR 
2. Insert a blank tape (one that has been initialized) 
3. Type the command: go save 
4. Press enter 
5. Roll to #21 
6. Type option 21 (Entire System save) 
7. Press enter (You will see a display listing what the backup will do) 
8. Press enter to continue 

 In the “Prompt for commands field”, enter: N 

 In the “Check Active Files field”, enter: N 

 In the “Message Queue”, enter: *NOTIFY 
(If you don’t do this you will have to stay and answer all prompts yes or no) 

9. Press enter 
 
If you get an error message asking you to respond to printer messages see step 9 in Pre-Backup 
procedure above. Enter a response to each. The backup screen will be redisplayed and the backup will 
proceed without the operator doing anything. 
 
The display will not change but you can tell the system is running by an “X” in the lower left corner of the 
display and the green light on the tape drive flashes. After about 1 ¾ hours, you will see a listing of 
libraries processed at the bottom of the display. The list will change occasionally. Be patient. 
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Full System Save - Encrypted 
 
A full system save should be performed regularly – at least quarterly – to ensure you have the 
information necessary to recover in the event of a disaster. Follow the instructions under the topic “Full 
System Backup” for initializing tapes and doing the pre-backup check. Instead of Option 21, you will be 
doing Option 22 (System data only) directly to tape, and Option 23 (All user data) to virtual tape for 
encryption before saving to physical tape: 
 
 
BACKUP – System Data 

1. Log on as QSECOFR 
2. Insert a blank tape (one that has been initialized) 
3. Type the command: go save 
4. Press enter 
5. Roll to #22 
6. Type option 22 (System data only) 
7. Press enter (You will see a display listing what the backup will do) 
8. Press enter to continue 

 On the line for Device, enter your physical tape device name (ie. TAP01) 

 In the “Prompt for commands” field, enter: N 

 In the “Check for active File” field, enter: N 

 In the “Message queue delivery” field, enter: *NOTIFY 
(If you don’t do this you will have to stay and answer all prompts yes or no) 

9. Press enter 
 

BACKUP – User data 
10. Type option 23 (All user data) 
11. Press enter (You will see a display listing what the backup will do) 
12. Press enter to continue 

 On the line for Device, enter your virtual tape device name – TAPVRT01 

 In the “Prompt for commands” field, enter: N 

 In the “Check for active files” field, enter: N 

 In the “Message queue delivery” field, enter: *NOTIFY 
13. Press enter 

 
ENCRYPT 

14. WRKJOBSCDE and find the job PKNIGHTLY. Enter Option 10 to submit immediately. This will 
encrypt the user data that has been backed up to virtual tape. 

15. When PKNIGHTLY is done, take Option 10 on PK2TAPE to transfer the encrypted file to tape. 
Make sure there is a clean, initialized tape in the tape drive. Do not try to add on to the Option 
22 backup, because the PK2TAPE process will first clear the tape. 

 



 
 

 
IBM Client i Access v7.1 Installation 

 
Go to \\sg1\WSApps\IBM Client Access and run the install for 32 bit 
or 64 bit version. 

 
 
Click OK to continue. 

 
 
Click Next to continue. 
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Accept the terms then click Next. 

 
 
Use the default location. Click Next to continue. 

 
 
Leave as MRI2924 - English. Click Next to continue. 

 
 
 
 

12/1/2010 2



Select Custom. Click on Next to continue. 

 
 
You will receive this screen when selecting the Complete or Custom 
install. Click on Next to continue. 

 
 
Do not make any changes. Click Next to continue. 
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Click on Install. 

 
 

 
 
Click on Finish. 
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Open System i Navigator by going to Start\All Programs\IBM i 
Access for Windows. 

 
 
Click on Yes to create connection. 

 
 
Enter 10.2.4.35 for Accounting and 10.2.4.36 for everyone else. 
“as400” for Description. 
Click on Next to continue. 

 
 
Select “Prompt every time”. Click Next to continue. 
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Click on Finish. 

 
 
Right click on the new connection then select “Create Desktop Icon”. 

 
 
Click OK to continue. 
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Open the Start or Configure Session by going to Start\All 
Programs\IBM i Access for Windows\Emulator\Start or Configure 
Session. 



 
 
Click on New Session. 

 
 
Change the Size to 27x132. Click OK to continue. 

 
 
 
 
 
 
Sign on with your Sandis User Name and Password. 
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Exit the session. 

 
 
Click Yes to save the session. 

 
 
Save as “i5.ws” in My Documents. Click Save to continue. 

 
 
 
Exit from this window. 
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From the Desktop, right click on the i Access session shortcut. Click 
on Properties. 

 
 
From the Options tab, select “5250 display emulation”. Click on 
Browse. 
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Browse to the “i5.ws” file in the My Documents folder. Click Open to 
continue. 

 
 
Click on OK to close. 

 
 
That concludes the installation process.  
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Importing an AS400 table into Microsoft Excel 
 

1. The computer must have IBM Client Access installed 
2. On the View menu select Toolbars then Client Access 
3. You will now have a toolbar with an icon that resembles an open book 
4. (If you let the mouse hover over it you will see the title, Transfer Data From 

AS/400) 
 

 
 
 
 

5. Click the Create New radio button 
6. Click OK  

 
 
 

 



7. Click Next 

 
 

8. Click Browse  

 
 
 

9. Select the Library that contains the table you want to import 

 

 



10. Select the file you need or click on the + sign and select the member files you 
need 

11. Click OK 

 
 

12. Click Next 

 
 
13. Click Next 

 

 



14. Click Finish 
15. The data will begin to transfer 

 
 

16. Wait while the data is transferred.  This could take several minutes. 

 
 
 

17. Once the transfer is completed you will have a copy of the data on the AS/400 
You can manipulate the data but can not save it back to the AS400 

 



IPL (Reboot the i5) 
 
Normal IPL: 
 
1.  At a command prompt enter PWRDWNSYS and press F4 
 

Change Controlled end delay time to:  300    (300 seconds is 5 minutes) 
Change Restart after power down to:  *YES 
 

2.  Press Enter 

 
 
 
 
 
“B” IPL (use only when applying firmware PTFs): 
 
1.  On the front panel of the i5 press the down arrow until the display reads “02” then press the center (enter) button. 
 
2.  Press the down arrow until the panel reads “B” and press the center (enter) button. 
 
3.  Press the down arrow until the panel reads “T” and press the center (enter) button. 
 
4.  The display should now read “02  B  N   T” 
 
 
5.  At a command prompt enter PWRDWNSYS and press F4 
 

Change Controlled end delay time to:  300    (300 seconds is 5 minutes) 
Change Restart after power down to:  *YES 
 

6.  Press Enter 

 
 



IBM iSeries Access Software 
 
The latest version of Client Access Express – or iSeries Access – will be on the i5.  As the i5 gets automatic updates, 
new PTFs, or version upgrades this copy of Client Access will be upgraded as well. 
 
Client Access can be copied from the following location onto a Windows server for distribution. 
 
\\alr400\QIBM\ProdData\Access  The folder called Windows contains the Client Access files for Windows. 
 

 
 
- or - 
 
(IFS view showing QIBM/ProdData/Access/Windows/Image32…) 
 

 



iSeries Navigator- Printer Tasks 
 
Open The IBM iSeries Navigator 
 

 
 
Log on using your I5 User ID and Password. 
 
 
Printers and Print Jobs: 
 
Open Basic Operations and then Printers. 

 
 
Select a printer to display the documents (print jobs) for that printer in the right-hand window. 

 
 
 
From the File menu in the iSeries Navigator, there are several options which apply to the selected document.  

Most have a corresponding icon on the tool bar. 
Open  Open the selected print job.  Once open you can print or view it. 
Reply    Reply to Messages. 
Hold    Put the print job on Hold. 
Release   Release job to begin printing. 
Delete     Delete the print job. 
 
Note: Print and Print Preview menu items are for printing a list of print jobs.  To print or 
view a specific job, you must first open it. 
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Print a specific document: 
Open the document by doing one of the following: 

Double click the document. 
From the File menu click Open.  

The Viewer window will open and the document will be displayed. Large documents will take some time. 
 
In the Viewer window use the File menu and select Print. 
The Print options window will open. 
 
Click Print to print the entire document. 
To print specific pages mark Select Pages from a List or Select Pages by Range then click the Select 
button. 

 
 
To select a range of pages enter the From Page and To Page, click the Add, and then click Select.  
To select specific pages select each page you want in the Pages: window then click Select. 
Once pages are selected you will be returned to the print window.  Click Print to print the selected pages. 
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Move or Copy (Send) a document to a different printer: 
 
Open Basic Operations and then Printers. 
 
Select a printer to display the documents for that printer in the right-hand window. 

 
 
Move a document: 
Select a document to be moved and drag it to the printer in the right-hand column that you want it moved to.  
The document will be moved to the destination printer.  For large documents this could take some time. 
 
Copy a document: 
Select a document to be copied and drag it to the destination printer using the right-hand mouse button 
instead of the normal left-hand button.  When you drop the document into the destination printer you will be 
given the option of Move Here or Copy Here.  Select Copy Here and a copy of the document will be added 
to the printer.  
 
 
 
Delete a document: 
 
Open Basic Operations and then Printers. 
 
Select a printer to display the documents for that printer in the right-hand window. 

 
 
Select the document to be deleted. 
 
From the File menu select Delete or click the black “X “on the toolbar. 
In the Confirm Delete window verify the correct document is listed then click Delete. 
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Answer Printer Messages: 
 
Open Basic Operations and then Printers. 

 
 
If a printer is waiting for a message it will have a “word balloon” along with the printer icon. 

 
 
The list of documents in the right-hand window will indicate which document (print job) has the message. 

 
 
Select the printer or the document that has the message. 
From the File menu select Reply or click on the reply button  on the toolbar. 

 
 
 
From the File menu in the iSeries Navigator, there are several options which apply to the selected print job 
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Configuring a Local Printer as an i5 Printer 
 
 
Log onto the I5 as yourself (must have special permissions) 

 
 
Click OK 

 
 
On the Configure PC5250 window: 
Enter the printer name (the system will assign the next available number if you don’t specify a name). 
Under Type of Emulation, Select the “Printer” radio button. 
Click Setup. 
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Click to put a checkmark in Transform print data to ASCII on iSeries. 
Use the down box for Printer model: and select a printer (HP IIP works for most printers). 
Click OK. 

 
 
You will return to the Configure PC5250 window 
Click OK again 
 
The printer has been created and you should get the following window. 
Click on the Minimize button in the upper right hand corner to minimize the window. 

 
 
Start another Client Access session (log on to i5 again leaving the previous one minimized) 
Enter the command wrkdevd prt* or wrkdevd prt25 (typing the entire printer name) 
 
Scroll to the printer you just created and enter a 2 in front of it to change the printer description. 
 
Scroll down to the printer description and enter a description.  
Press Enter to save the changes. 
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Press F3 again to return to your main menu. 
 
Configure the users default printer to be the one you just created. 
Enter wrkusrprf <user name> 
 
Enter a 2 in front of the user to change the profile. 
 
Press F10 
Scroll to the Print device and enter the name of the printer you just created. 
Output Queue should be *WRKSTN 

 

 
 
Press Enter to save the changes 
Press F3 to return to the main menu 
Sign off the I5. 
 
 
 
 
 
Create a shortcut on the user’s desktop for the printer session: 
 
Open the printer session. 
From the File menu select Save As. 
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Save the file on the Desktop or in the default location and call it Local Printer or whatever you like. The file 
extension is ".WS" 
Click Save. 

 
 
 
 
If you saved the printer session in the IBM folder, you can create a shortcut to is for the desktop just like any 
other Windows shortcut. 
 
If you want the printer session to start every time the computer boots up put the shortcut into the Startup 
Folder in the Windows Taskbar. 
 
 
Configure AS/400 client access PTF software Patch 
Go to the i5 client access PTF Software patch folder in \\alta main\alta\drivers folder and run setup. 
A copy is also located in \ \alta _main \is\i5 folder. 
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Lock All Users out of  the AS/400 
 

 
Use the AS/400 system console only! 
Log on as sysopr user type 
 
Menu item 13 Communications 
 
From the Work with All communication devices menu end or start the QINTER subsystem. 
 
This will stop any new connections but will not affect the console from logging into the AS/400.  
Users already logged on will remain connected.  DDS will not be able to access the system.  To 
allow users to log back on all that’s necessary is to start the subsystem again. 
 
Lock users out: 
 
Menu item  16 - End QINTER subsystem. 
 
 
Allow Users to Log In: 
 
Menu Item 6 - Start QINTER subsystem. 
 
 
 
Lock users out and terminate all actively connected users (except console): 
 
On the command line enter:  ENDSBS QINTER *IMMED 
 
 
Alternatively use the procedure for taking the Ethernet1 device out of service  
See the procedure titled “AS/400 Ethernet” 
This will allow the console and DDS to access the system but not local users.  TCP, SANDIS 
licensing must be stopped and restarted with this procedure. 



Mapping a Drive to the I5 on a Windows PC 
 
This is a two step process.  Create a share on the AS400 then on a PC map a network drive to that share. 
 
NetServer Must be Started on the i5 
 
Network Services must be running on the I5 to enable the i5 to share files with Windows. 
 
To check its status or configuration start iSystem Navigator.  Select Network, Servers, TCP/IP, then iSeries 
NetServer (right click to start or stop services) 

  
 
 
The NetServer can also be started on the Command line by entering:  strtcpsvr *netsvr 
 
 
Creating a Windows Network Share on the I5 
 
Open IBM Client Access Operations Manager. 
Expand the I5 then File System.   
Click once to select Integrated File System and browse to the folder you want to share. 
 

 
 

4/29/2010  1



In the right-hand window, right click the folder you want to share.   
Select Sharing then New Share… 
Note:  Select Root to share the entire file system. 

 
 
On the NetServer File Share window enter: 
    Description (Name of the share to be used when mapping drives to the I5) 
    Select the Access you need (Read only or Read and Write) be cautious about granting write access. 
    Select the number of users that can connect to the share.  I specified one person to help restrict it a bit. 

 
 
Note: Check Writing Program Signatures are in QDLS\ICSTRANS so can make a Read/Write Share here. 
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On the File Shares menu the new share will be displayed. 

 
 
 
Mapping a Windows Network Drive to the I5 Share 
 
Start Network Services (must be enabled on the I5 to enable Windows to connect.) 
On the I5 Command line enter:  strtcpsvr *netsvr 
 
From the Start menu, desktop, or My Computer, right click My Network Places.   
Select Map Network Drive… 
 

 
 
Select a drive letter and enter the name of your i5 (for example: \\alr400) and click Browse. 
You can also enter the full path (for example  \\alr400\ name of the folder on the i5). 
Click Finish. 
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Network Interfaces – Status, Stop & Start, Routes, etc. 
 
 
On the command line enter NETSTAT. 

 
 
 
Check Status 
 
Take Option 1. Work with TCP/IP Interface Status 

 
 

 
 
For additional detail about an interface, select it and take option 5. Display details. 

 
 
For information about an interface’s routing, select it and take option 8. Display Associated Routes. 
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For information about an interface’s routing, select it and  take option 12. Work with configuration status. 
Note: ETHLININT = Internal LAN  (10.2.4.35 and 10.2.4.36) 1 GB  

 
 
 
Display TCP Routes 
 
Take Option 2. Display TCP/IP route information. 

 
 

 
 
Take Option 5 to Display details for a specific route 
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Press F11 to Display route type. 

 
 
 
Press F11 again to show Next Hop. 
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TCP/IP Connection Status (Ports) 
 
Take Option 3. Work with TCP/IP connection status 

. 
 

 
Press Page Down for more. 

 
 
Press F11 to show Byte count. 
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Network Printer Set-Up
 
This example establishes OutQueue NAHP2P for laser printer at IP address 204.216.192.154 that will use message 
queue NAHP2Q. 
 
Create a Message Queue
At the command line type: CRTMSGQ – Press F4 
Name = NAPH2Q (Printer Queue Name) 
Library = QUSRSYS 
Text = Unit 3 SANDIS Printer (Description) 
Press Enter or Click OK 
Look for Msg at bottom to confirm 
 
Create an Output Queue
At the command line type: CRTOUTQ – Press F4 
Output Queue = NAHP2P (Printer Name) 
Library = QUSRSYS 
Remote System = *INTNETADR – Press F10 (Click Advance) 
 
Remote Printer Queue = ‘RAW’ 
Click on down arrow to Page Down 
Writers to Auto Start = 1 
Queue …….. = NAHP2Q 
Library = QUSRSYS 
Connection = IP 
Destination = *OTHER 
Press Enter twice to continue 
Manufacturer Type and Model = *WSCST – Press Enter 
Workstation customizing object = HP4_198 for Portrait or HP4_198L for Landscape 
Library = QGPL 
Internet Address = 204.216.192.154 (TCP/IP address) or Host Table Name 
Page Down 
Text Description = Unit 3 SANDIS Printer 
Press Enter 
Look for Msg to confirm 
 
Assigning Users (Must have *SECADM Authority) 
At the command line type: WRKUSRPRF SDNA* - Press Enter 
Highlight all the users for that unit 
Click Change 
Press F10 (Additional Parameters) 
Page Down until you see the MSGQ and Output Queue 
MSGQ = NAHP2Q 
Output Queue = NAHP2P 
Library = QUSRSYS 
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Instructions for Modifying a Workstation Customizing Object 
(WSCST) 
 
 Technote 
Several documents have been created on specific modifications to workstation customizing objects (or WSCSTs) for use with Host
Transform (HPT). This document was created to provide standard instructions for:  
o Deciding which MFRTYPMDL setting to use as a base, 
o Retrieving the source for the system-supplied workstation customizing object, 
o Modifying the workstation customizing object source, 
o Creating the modified workstation customizing object, and 

Using the modified workstation customizing object with a *LCL or *RMT device description, a *LAN device description, a Rem
Queue (RMTOUTQ), a Personal Communications 5250 (PC5250) printer session, or a third-party printer emulation package. 

o 

The section on using the modified workstation customizing object consists of links to other documents (for example, one documen
the modified workstation customizing object with a *LCL or *RMT device description, and another document is for using the modif
workstation customizing object with a *LAN device description, and so on. 
 
Note: A single modified workstation customizing (or *WSCST) object can be used with any number of *LCL or *RMT device descr
device descriptions, Remote Output Queues (RMTOUTQs), Personal Communications 5250 (PC5250) printer sessions, or third-part
emulation sessions. However, if any changes are made to the WSCST source code and the *WSCST object is recreated, then each
that modified *WSCST object must be ended and restarted for the change to take affect for that writer. 

Caution: These instructions are provided as is . Any assistance with editing the Workstation Customization Table must be done 
consulting agreement. 

 
This document was last updated on 04/09/2009. 
 
 
Deciding Which MFRTYPMDL Setting to Use as a Base  
 
First, you decide which Manufacturer type and model (MFRTYPMDL) setting to use as a base for the modified workstation customiz
(WSCST). If you are already using Host Print Transform (HPT) to print to this printer, then display the printer device description u
Display Device Description (DSPDEVD ) command or display the Remote Output Queue using the Work with OUTQ Description (W
command and look at the value for the Manufacturer type and model (MFRTYPMDL) parameter. 
 
If you do not know which WSCST to retrieve, type the RTVWSCST command, and press the F4 key to prompt the command. Typ
*TRANSFORM for the device type, and press the Enter key, then press the F4 key to prompt on the manufacturer type and mod
you a long list of all supported workstation customization tables. Compare this to the user's guide for your printer to decide which
choice for your printer. When in doubt, configure your printer to use Host Print Transform before modifying a WSCST to verify tha
correctly. Once you have decided which manufacturer type and model works for your printer, proceed to the next step. 
 
The examples to follow are using a manufacturer type and model value of *HP4 (which is used for HP LaserJet 4 and compatible 
source member value of HP4 . 
 
Retrieving the Workstation Customizing Object (WSCST) Source  
 
You are ready to retrieve the source for the system-supplied workstation customizing object. It is recommended that you retrieve
into a QTXTSRC file that is in a library in your System Library List. This makes it easier to configure the device description because
the library name of the WSCST to *LIBL. The best choice is probably the library QGPL because it is typically in the System Library
generally already has a QTXTSRC file. 
 
The Retrieve WSCST source (RTVWSCST ) command for an HP LaserJet 4 printer looks similar to the following: 
 
RTVWSCST DEVTYPE(*TRANSFORM) MFRTYPMDL(*HP4) SRCMBR(HP4) SRCFILE(QGPL/QTXTSRC) TEXT('Modified W
LaserJet 4')  
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If needed, press the F4 key to prompt the command. Press the Enter key to run the command. 
 
Making Additional Changes to a Modified Workstation Customizing Object (WSCST) Source  
 
If you have already made some modifications to a WSCST source member, you will want to edit the source member again without
source for the system-supplied workstation customizing object over again. If you have already made changes to a WSCST source 
then use the RTVWSCST command a second time, you will overwrite the changes that you previously had made to that WSCST s
 
If you have created a modified WSCST object, but cannot find the WSCST source code used to create that WSCST object, refer to 
Rochester Support Center knowledgebase document: 
 
15433348, Finding the Source Code for a Modified Workstation Customizing Object (WSCST):  
 
Modifying the Workstation Customizing Object (WSCST) Source  
 
Use PDM or SEU to edit the source file member. To do this, type one of the following commands:  
o WRKMBRPDM FILE(QGPL/QTXTSRC) MBR(*ALL) MBRTYPE(*ALL)  
o STRSEU SRCFILE(QGPL/QTXTSRC) SRCMBR(*SELECT)  
If needed, press the F4 key to prompt the command. Press the Enter key to run the command. Select Option 2 (Edit) next to the
source file member, and press the Enter key to edit the source file member. 
 
Suggestion: To help remember which MFRTYPMDL setting was retrieved to create the WSCST source member, add a comment a
source member that shows details on the Retrieve WSCST source (RTVWSCST ) command that was used. For example: 

 Columns . . . :    1  71            Edit                         
 QGPL/QTXTSRC  
SEU==>                                                                     HP4  
 FMT **  ...+... 1 ...+... 2 ...+... 3 ...+... 4 ...+... 5 ...+... 6 ...+... 7  
        *************** Beginning of data 
*************************************  
0000.01 :WSCST DEVCLASS=TRANSFORM.                                             
   
0000.02       /**************************************************************/  
0000.03       /* RTVWSCST DEVTYPE(*TRANSFORM) MFRTYPMDL(*HP4) SRCMBR(HP4)   */  
0000.04       /*          SRCFILE(QGPL/QTXTSRC)                             */  
0000.05       /*          TEXT('Modified WSCST for HP LaserJet 4')          */  
0000.06       /*                                                            */  
0000.07       /* Modified WSCST object based on *HP4 that ....              */  
0000.08       /**************************************************************/  
0000.09  
0000.10     :TRNSFRMTBL.  
0000.11     :PRTDTASTRM  
0000.12       DATASTREAM=HPPCL5.  
0000.13     :NOPRTBDR  
0000.14       OPTION=TOP  
0000.15       ORIENT=PORTRAIT  
0000.16       DATA =  240.  
 
 F3=Exit   F4=Prompt   F5=Refresh   F9=Retrieve   F10=Cursor   F11=Toggle  
 F16=Repeat find       F17=Repeat change          F24=More keys  

 
 
Creating the Modified Workstation Customizing Object (WSCST)  
 
After the WSCST source member has been edited and saved, you are ready to create a new Workstation Customization Table (WS
Create WSCST (CRTWSCST ) command looks similar to the following: 
 
CRTWSCST WSCST(QGPL/HP4) SRCMBR(*WSCST) TEXT(*SRCMBRTXT) SRCFILE(QGPL/QTXTSRC) AUT(*LIBCRTAUT
REPLACE(*YES) 
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If needed, press the F4 key to prompt the command. Press the Enter key to run the command. 
 
Using the Modified Workstation Customizing Object (WSCST)  
 
After the WSCST object has been created, it must be specified in the configuration on the IBM Power Systems so the writer knows
with the modified WSCST object, rather than using one of the system-supplied WSCST objects. How this is specified depends on h
is configured on the Power Systems. 
 
For *LCL, *RMT, and *LAN printer device descriptions, the modified WSCST object can be specified in the printer device descriptio
the writer and varying off the printer device description. Then use the Change Device Desc (Printer) (CHGDEVPRT ) command to
Workstation customizing object (WSCST) parameter to the name of the modified WSCST object. Then the printer device descriptio
varied back on and the printer writer started again. 
 
For Remote Output Queues, the modified WSCST object can be specified in the output queue description by ending the writer and
Change Output Queue (CHGOUTQ ) command to set the Workstation customizing object (WSCST) parameter to the name of the 
WSCST object. Then the remote writer can be started again. 
 
For *VRT device descriptions, it depends on printer emulation software or hardware being used. Some third party printer emulatio
requires you to manually change the WSCST parameter in the printer device description, just like for a *LCL, *RMT, or *LAN print
description. However, other printer emulation software, including PC5250, require that any modified Workstation Customizing Obj
be specified in the printer session profile; the change will be automatically reflected in the *VRT printer device description the nex
printer session connects to the Power Systems. If the WSCST is manually changed in the printer device description, as in the case
printer session, then it will get set back to *NONE when the printer session connects to the Power Systems. 
 
For specific instructions on using Host Print Transform (HPT) with your device descriptions and/or Remote Output Queues, refer to
following documents: 
 
7532429, Using Host Print Transform (HPT) with an *LAN Device Description:  
11401901, Using Host Print Transform (HPT) with a Remote Output Queue (RMTOUTQ):  
11402020, Using Host Print Transform (HPT) with an *LCL or *RMT Device Description:  
23354524, Using Host Print Transform (HPT) with a PC5250 Printer Session at V5R1M0 and Above:  
13235847, Using Host Print Transform (HPT) with a Third-Party Emulation Package:  
 

For More Information  
For More Information  
 
Sources for additional information on workstation customizing objects include the following:  
o IBM Redbooks publication IBM AS/400 Printing IV (GG24-4389) has a section going into detail for customizing a WSCST objec
document is available on the Internet using the following Web site: 
 
Redbooks publication IBM AS/400 Printing IV abstract:http://publib-
b.boulder.ibm.com/Redbooks.nsf/9445fa5b416f6e32852569ae006bb65f/5ad1f339df9fa03a8525659d002a567b?O 
 
Redbooks publication IBM AS/400 Printing IV (GG24-4389-00): http://www.redbooks.ibm.com/pubs/pdfs/redbooks/

o The Printer Device Programming publication documents the parameters in the printer device description for host print transfo
writers only have the MFGTYPMDL parameter. This document is available on the Internet using the following Web sites: 
 
AS/400e Printer Device Programming Version 4 , SC41-5713-03: 
http://publib.boulder.ibm.com/pubs/pdfs/as400/V4R4PDF/QB3AUJ03.PDF  
 
IBM eServer iSeries Printer Device Programming Version 5 , SC41-5713-04: 
http://publib.boulder.ibm.com/pubs/html/as400/v5r1/ic2924/books/c4157134.pdf 

o The Workstation Customization Programming publication has detailed documentation of the tags within the WSCST object s
document is available on the Internet using the following Web site: 
 
AS/400e series Workstation Customization Programming Version 4 , SC41-5605: 
http://publib.boulder.ibm.com/pubs/pdfs/as400/V4R3PDF/QB3AQ600.PDF 
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Hardcoding Page Orientation using a 
Modified WSCST Object 
 

 Technote 
Note: This document was previously entitled "Hardcoding Print Orientation". 
 
This document provides instructions for forcing spooled files to print with a 
particular paper orientation (such as portrait or landscape) when printing 
through Host Print Transform (HPT). This is done by retrieving and modifying 
a Workstation Customization Table (WSCST) and changing the values in the 
Paper Orientation (PRTORIENT) tags. 
 
This document was last updated on 08/18/2010. 

Caution: These instructions are provided as is . Any assistance with 
editing the Workstation Customization Table must be done through a 
consulting agreement. 

 
Basic Steps for Creating and Using a Workstation Customization 
Object  
 
The following are the basic steps for creating and using a Workstation 
Customization Object (WSCST). Regardless of the particular issues you are 
attempting to resolve, these steps must always be taken. This information is 
intended to provide a 'quick start' to creating a WSCST object for users who 
have at least some familiarity with creating them and with configuring 
printers. 
 
Note: Additional, in-depth details for creating a WSCST object can be found 
in the following document: 
 
8692422, Instructions for Modifying a Workstation Customization 
Object (WSCST):  
 
The following are the basic 'quick start' steps. 
 
Step 1: Retrieve the WSCST source code. Type the following command on 
the operating system command line: 

Important Note: Use the Manufacturer type and model (MFRTYPMDL) that 
is appropriate for your printer. Also, the Source member (in the following 
example, HP4 ) is a name that is appropriate to your customizing object. 
This is what you will be calling your workstation customizing object in Step 
3. 

 
RTVWSCST DEVTYPE(*TRANSFORM) MFRTYPMDL(*HP4) 
SRCMBR(HP4) SRCFILE(QGPL/QTXTSRC)  
 
Press the Enter key. 
 
Step 2: Edit the source code by using PDM or SEU:  

To use PDM, on the operating system command line type the following: 
 
WRKMBRPDM FILE(QGPL/QTXTSRC) MBR(HP4)  

o 
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Press the Enter key. Select Option 2 to edit. 

o To use SEU, on the operating system command line type the following: 
 
STRSEU SRCFILE(QGPL/QTXTSRC) SRCMBR(HP4)  
 
Press the Enter key. 

Make any changes necessary changes to the WSCST object source. Refer to 
the following section Changing the Paper Orientation (PRTORIENT) 
Tags in the WSCST Source Code to make your changes, then save and 
exit. Continue with Step 3. 
 
Step 3: Create the WSCST object using the CRTWSCST command. On the 
operating system command line, type the following: 

Important Note: Match the SRCMBR name from Step 1 to the WSCST 
object name that is created in this step. 

 
CRTWSCST WSCST(QGPL/HP4) SRCFILE(QGPL/QTXTSRC)  
 
Press the Enter key. 
 
Step 4: Add the WSCST to the printer configuration by using the Change 
Device Print command (CHGDEVPRT ), the Change Output Queue command 
(CHGOUTQ ), or by changing the PC5250 printer emulation session 
configuration.  
o To add the WSCST to a device description, on the operating system 

command line type the following: 
 
CHGDEVPRT DEVD(device_name) TRANSFORM(*YES) 
MFRTYPMDL(*WSCST) WSCST(QGPL/HP4)  
 
Press the Enter key. 

o To add the WSCST to a remote output queue description, on the 
operating system command line type the following: 
 
CHGOUTQ OUTQ(queue_name) TRANSFORM(*YES) 
MFRTYPMDL(*WSCST) WSCST(HP4)  
 
Press the Enter key. 

o To add the WSCST to a PC5250 printer emulation session, do the 
following:  
 
a In the PC5250 printer session, click on Communication > Configure 
. 
b Click on the Setup button.  
c In the Configure PC5250 Printer Emulation window, select the box next 
to Transform Print Data to ASCII on the iSeries and select the 
Printer Model value of *WSCST. 
d In the same window, specify the name of the WSCST in the 
Customizing Object parameter and the library where it is found in the 
Library parameter (for example, Customizing Object HP4 and Library 
QGPL). 
e Click OK three times. 
f Click File > Save to save the configuration. 

 
Note: If any changes are made to the WSCST object source code after the 
CRTWSCST command has been issued, it is necessary to issue the 
CRTWSCST command again. The printer writer must be ended and restarted 
for the changes to take effect. 
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Changing the Paper Orientation (PRTORIENT) Tags in the WSCST 
Source Code  
 
If orientation is causing a problem, modify the :PRTORIENT tags. Do not 
change the 'ORIENT = ' values, because the writer needs these to send the 
'DATA = ' value. For instance, if printing landscape and portrait is required, 
find the 'ORIENT = LANDSCAPE' and change the data value to the same as in 
the 'ORIENT = PORTRAIT' tag. 
 
The default setting for the Paper Orientation (PRTORIENT) tags in the 
WSCST source code for *HP4 is as follows: 
 
    :PRTORIENT 
     ORIENT=PORTRAIT 
     DATA ='1B266C304F'X. 
   :PRTORIENT 
     ORIENT=LANDSCAPE 
     DATA ='1B266C334F'X. 
   :PRTORIENT 
     ORIENT=RTT180 
     DATA ='1B266C324F'X. 
   :PRTORIENT 
     ORIENT=RTT270 
     DATA ='1B266C314F'X.  
 
There is a :PRTORIENT tag for each of the four orientations: PORTRAIT (0 
degrees), LANDSCAPE (90 degrees), RTT180 (180 degrees or upside-down 
portrait), and RTT270 (270 degrees or landscape right). If you need to 
change one of them, read the printer documentation for correct control 
string or just copy the DATA value from one of the other tags. Change only 
the DATA value. 
 
Examples of Changing the Paper Orientation (PRTORIENT) Tags  
 
To print everything in portrait, set the DATA portion to '1B266C304F'X for all 
four orientations. For example: 
 
    :PRTORIENT 
     ORIENT=PORTRAIT 
     DATA ='1B266C304F'X. 
   :PRTORIENT 
     ORIENT=LANDSCAPE 
     DATA ='1B266C304F'X. 
   :PRTORIENT 
     ORIENT=RTT180 
     DATA ='1B266C304F'X. 
   :PRTORIENT 
     ORIENT=RTT270 
     DATA ='1B266C304F'X.  
 
To print landscape with the opposite orientation, for instance if using pre-
punched paper and the holes are on the wrong side, swap the DATA portions 
for the LANDSCAPE and RTT270 orientations. For example: 
 
    :PRTORIENT 
     ORIENT=PORTRAIT 
     DATA ='1B266C304F'X. 
   :PRTORIENT 
     ORIENT=LANDSCAPE  
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      DATA ='1B266C314F'X. 
   :PRTORIENT 
     ORIENT=RTT180 
     DATA ='1B266C324F'X. 
   :PRTORIENT 
     ORIENT=RTT270 
     DATA ='1B266C334F'X.  
 
To create the WSCST object and implement it, perform Steps 3 and 4 
(above). 
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For MIS Use Only – 

 
ODBC Database Connection - Naming Conventions 

 
 

Use the following ODBC naming convention with databases on the i5. 
 

sUFS  RCDTAHQ 
sSANDIS  SAND400 
sSIR  SIRSDTA 
sNedaSoft  NEDASOFT 
sNGS  ALTANGS 

 
 

Creating an ODBC connection to the AS400 
for Microsoft Access 

 
 

Windows XP: 
1. Start – Control Panel –  Administrative Tools – Data Sources (ODBC) 

Alternate path:   
Start menu – All Programs - IBM iSeries Access for Windows - ODBC Administration 

 
2. Select the System DSN Tab 

 
3. Click ADD 
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4. Select Client Access ODBC Driver (32-bit) 
 

5. Click Finish 

 
 
 
 

6. On the General Tab, enter whatever you want for the Data source name and leave the System 
configured for 10.2.4.35.  You can also use 10.2.4.36 or ALR400. 

 

 
 
 

 2



7. Click the Server tab 
8. In the SQL default library: enter the library that contains the tables you want to access 
9. (If you want multiple libraries, repeat the ODBC process and save each with a different name) 

 
IMPORTANT:  MAKE THE CONNECTION READ ONLY: 
10. On the Other tab, click the Read-Only (Select statements only) radio button 
11. Click OK 

 
 
 

The ODBC connection has been created 
12. Click OK 

 
 
 

13. Open or create a new Access database 
14. On the File menu select Get External Data… then Link Table… 
15. Under Files of type: at the bottom of the window, select ODBC Databases () 
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16. Click the Machine Data Source tab 
17. Select whatever you called the ODBC data source (AS/400 in this example) 
18. Click OK 

 
 
 

19. After a few seconds you will get a window that shows all the tables in the AS/400 database 
20. Select the table or tables you want to import and click OK  
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21. Select the field that will be the Unique key field or leave it with no fields selected 
22. Click OK  

 
 
 

23. A read only link is created (Important: when creating the ODBC data source be sure to make it read 
only!) 

24. The database can be used like any other except that data cannot be changed, deleted or added. 
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Print I5 Hardware Configuration 
 
 
Log onto the I5. 
 
 

On a command prompt enter STRSST    
 
Log into SST with QSECOFR user ID. Note – the password will probably NOT be the same as the normal QSECOFR 
logon password, and if you don’t remember what it is, it may need to be reset. If you reset to *DEFAULT, it will be 
QSECOFR (case sensitive), and upon logging in, you will have to create a new password. 
 
Take option 1 Start a service tool    
 

Take Option 7 Hardware service manager   
 

Press F6 for Print configuration  
 
The configuration should print on your default I5 printer. 
 
Press F12 Cancel three times  
 
Press F3 to Exit   
 
Press the Enter key to end the SST session  
 
You’ll return to your normal I5 screen. 
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Downloading and Loading PTFs from IBM’s Fix Central 
http://www-933.ibm.com/support/fixcentral/ 
Select from the various drop-downs, and make your way to the logon screen. Then you’ll be able 
to select cumulatives and hipers or individual fixes, if desired. Normally, individual fixes can be 
ordered directly using option 6 on the PTF menu. But for these larger ones, Fix Central is a good 
place to start if you want them right now. If you can wait, you still have the option to order discs 
from IBM. 

 

http://www-933.ibm.com/support/fixcentral/
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It’s best to use Download Director rather than FTP to download the PTFs, because it’ll remember 
where to restart in the event of an interruption. 

 
If you’ve downloaded the fixes to a local or network drive, you’ll need to copy or move them into 
the IFS directory you’ll be creating in step 2. In this case, it’s going to be PTFCatalogDirectory (in 
Root).  
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Note: Drag and drop may not work for the larger files. If you need to FTP them to the IFS, you’ll 
need to change the name format used, using the “quote site namefmt 1” ftp command. The 
following is a script that will transfer files from the DownloadDirector folder on your C drive to the 
PTFCatalogDirectory in the Root of the IFS: 
  
Start a command prompt from your PC, and change to the DownloadDirector folder  

C: cd \DownloadDirector  
Start an ftp to your i5 (using your internal IP address or host name). Your entries are in blue (and 
variable in red): (Note that you will have to enter the QSECOFR password, but it won’t show on 
the screen) 

C:\DownloadDirector> ftp 10.96.69.94 
Connected to 10.96.69.74. 
220-QTCP at HQR400. 
220 Connection will close if idle more than 5 minutes. 
User <10.96.69.74:<none>>: qsecofr 
331 Enter password. 
Password:  
230 QSECOFR logged on. 
ftp> bin 
200 Representation type is binary IMAGE. 
ftp> quote site namefmt 1 
250 Now using naming format “1”. 
ftp> cd /PTFCatalogDirectory 
250 “/PTFCatalogDirectory” is current directory. 
ftp> put iptfxxx_x.bin 
200 PORT subcommand request successful. 
150 Sending file to /PTFCatalogDirectory/S8368V01.BIN 
226 File transfer completed successfully. 
ftp: 588259328 bytes sent in 60.78Seconds 9678.18Kbytes/sec. 
ftp> quit 
 

 
Installing i5/OS fixes from an image catalog 
 
To install your fixes from an image catalog, do the following steps: 
 
   1. Create a virtual optical device 
 
      It is possible that you used an image catalog that is associated with a virtual optical device to 
install PTFs before or to perform a software upgrade. If you did, you do not need to perform this 
step. If you do not have a virtual optical device, you must create one. 
          * To create a device description, type the following on any command line: 
 
            CRTDEVOPT DEVD(OPTVRT01) RSRCNAME(*VRT) ONLINE(*YES) TEXT(Virtual 
Optical Device) 
 
          * To determine whether a virtual optical device exists, type the following: 
 
            WRKDEVD DEVD(*OPT) 
 
            A virtual optical device is indicated by a device type of 632B. 
 
            To ensure that the device is active, press F14 (Work with configuration status). If the 
device is not active, type 1 to vary it on.  
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   2. Create an image catalog 
 
      Create an image catalog for the set of PTFs that you want to install. The Create Image 
Catalog (CRTIMGCLG) command associates an image catalog with a target directory where the 
preloaded images are loaded. 
 
      CRTIMGCLG IMGCLG(ptfcatalog) DIR('/PTFCatalogDirectory') CRTDIR(*YES) TEXT(Target 
Directory for Image Catalog PTFs) 
 
      Note: A directory can be associated with only one image catalog. 
 
   3. Add an image catalog entry 
 
          * Add an image catalog entry for fixes that you downloaded from Fix Central into an IFS 
directory (see above for instructions to get the files from the Download Director download into the 
IFS). You can add into the directory that is associated with the image catalog directory. 
 
                  ADDIMGCLGE IMGCLG(ptfcatalog) FROMFILE(iptfxxx_x.bin)  
                    TOFILE(iptfxxx_x.bin) 
 
 Do this for each file you’ve downloaded. 
 
   4. Load the image catalog 
 
      This step associates the virtual optical device to the image catalog. Only one image catalog 
can be associated with a specific virtual optical device. Type the following command to load the 
image catalog: 
 
      LODIMGCLG IMGCLG(ptfcatalog) DEV(OPTVRT01) OPTION(*LOAD) 
 
   5. Verify that the images are in the correct order 
 
      VFYIMGCLG IMGCLG(ptfcatalog) TYPE(*PTF) SORT(*YES) 
 
      The system puts the images in the correct order. By default, the volume with the lowest index 
is mounted; all the other volumes are loaded. Use the Work with Catalog Entries 
(WRKIMGCLGE) command to see the order of the images. 
      Note: If you are attempting to load individual PTFs with the Load PTF (LODPTF) command, 
only the PTFs on the volume set that is mounted can be loaded. 
 
   6. Install PTFs from virtual optical device 
 
      To install PTFs from an image catalog associated with a virtual optical device, see Installing 
fixes from media or Installing cumulative PTF packages. For the device name, enter the name of 
the virtual optical device that is associated with your image catalog (in this case, OPTVRT01). All 
the PTFs from the images that are either mounted or loaded will be installed.   
 
   7. Delete images from image catalog 
 
      Once you have successfully installed the fixes, you should remove the images from the 
catalog with the Remove Image Catalog Entries (RMVIMGCLGE) command. This is done one 
index number at a time. If you continue to add new images to the same image catalog without 
removing the old images, PTF install processing will attempt to install the fixes from all of the 
loaded images in the catalog. 
 



PTF Image Catalog Process 
1. Create a virtual optical device (if it doesn’t already exist) 

 
 
 
Do a WRKDEVD *OPT and F14 – to make it available. It’s a type 632B 

 
 
 



 
 
 
2. Create an image catalog  

This does two things: it creates an image catalog file in QUSRSYS (rcptfcat), and it 
creates a directory that it is related to in the IFS (RCPTFCatalogDirectory): 

 
 



 
 

 
 
3. Add an image catalog entry 

 The image catalog entries will be the PTF files that have been downloaded from Fix 
Central, and can be dragged and dropped into the IFS directory just created: 

 
 



Drop in the “RCPTFCatalogDirectory” under root. 
 
 

 
4. Load the image catalog 

This step associates the virtual optical device (optvrt02) to the image catalog. 

 
 
 
5. Verify that the images are in the correct order 



The system puts the images in the correct order. By default, the volume with the lowest 
index is mounted; all the other volumes are loaded. Use the Work with Catalog Entries 
(WRKIMGCLGE) command to see the order of the images. 

 

 
6. Install PTFs from virtual optical device 



 

 
7. Delete the images from image catalog – cleanup. 
RMVIMGCLGE for RCPTFCAT, each index number 
 
 
 
 
 
 
 



Adding PTF from a disc to the RCPTFCAT 
 
 

  
 
 



Put a Spool File on Save 
 
This will keep the file in the spool after it’s been printed.  The file will be available for additional actions. 
 
Locate the file you want to put on Save 
Take option 2 = Change 

 
 
 
Press F10 Additional Parameters 
Press Page Down 
 
Change Save file to *Yes 
 

 



Restoring Files from Tape 
 
Restoring to the Same Library and Overwrite the Existing File: 
 
On the command line enter RSTOBJ and press F4 

• Objects: Enter the name of the file. 
• Saved library:  Enter the name of the library the file was originally in when the tape was made. 
• Device:  Enter the name of the tape drive – TAP01 

 

 
 
Press Enter to restore the file to the original location. 
 
 
 
Restoring to a different Library: 
 
If you want to restore the file to a different library than the one it originally came from, enter the destination library on 
the Restore to library line. 

• F10 for more options 
• Page down 
• Enter the name of the destination library in the Restore to library line. 

 

 



Working with Files 
 
STRPDM = AS/400 Programming Screen 
 Work with members = files 
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Getting descriptions for codes using the  

STABCOD file in the SAND400 Library 
For all Records: 

TSTAT = Status (blank = Active and “D” = Deleted) 
 
Service Coordinator name: 

TFLDK = CASM 
TCODE = SC code (like T0A) 
TDESC= SC name 

 
County name: 

TFLDK = CNTY 
TCODE = County code 
TDESC= County name 

 
Ethnicity: 

TFLDK = ETHN 
TCODE = Ethnicity code 
TDESC= Ethnicity 

 
Language: 

TFLDK = LANG 
TCODE = language code 
TDESC= Language 

 
Legal Status: 

TFLDK = LEGL 
TCODE = Legal Status code 
TDESC= Legal Status 

 
Residence Type: 

TFLDK = RTYPE 
TCODE = Residence code 
TDESC= Residence Type 

 
Service Code: 

TFLDK = SRVC 
TCODE = Service Code 
TDESC= Service Code 

 
Client Status: 

TFLDK = STUS 
TCODE = Status code 
TDESC= Client Status 

 
SC Unit: 

TFLDK = UNIT 
TCODE = Unit code (First 2 characters of the SC Code like VO) 
TDESC= Unit 



  

ID Notes Not Showing Up – System Date Needs to be Started 
 
 
The command SYSDATE is run on the job scheduler Weekly on Tuesdays at 6:46 AM.  If it doesn’t run, ID notes 
entered will not show up on the consumers’ records until the command is run. 
 
 
Run SYSDATE Manually: 
 
On the command line type:  CALL SYSDAT and press ENTER 
 
 
 
Run SYSDATE Manually (Alternate method): 
 
From SANDIS: 
On the command line enter: WRKJOBSCDE 
 
Scroll down and click to select SYSDATE. Then click the Submit immediately button at the top of the screen. 
 
Click OK on the next screen. 
 
 
From Client Access: 
On the command line enter: WRKJOBSCDE 
 
Scroll down to SYSDATE and take option 10 (Submit immediately) 
 



System i Navigator 
 
Open IBM System i Navigator 
 

 
 
Log on using your iSeries User ID and Password. 
 
Printers and Print Jobs: 
 
Open Basic Operations and then Printers. 

 
 
Select a printer to see the print jobs in the right-hand window. 
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From the File menu in System i Navigator, there are several options which apply to the selected 
printer job (print output). 
 

 

Open Open the selected print job. Once open you can print or view it.
Reply Reply to Messages. 
Hold Put the print job on Hold. 
Release Release job to begin printing. 
Send Send it to a different printer. 
Move Move it to a different printer or output queue. 
Delete 
  

Delete the print job. 
 

Note: Print and Print Preview menu items are for printing a list of 
print jobs. To print or view a specific job, you must first open it. 
 

 
Printing a specific job:
Open the print job in document Viewer to see the document by doing one of the following: 
 Double click the print job. 
 Use the file menu to “Open” the selected print job. 
 
From the file menu in the Viewer select Print to open the print options window. 

 
Select the printer to use and pages to print as you would any Windows print job. 
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Move or Copy a document to a different printer: 
 
Open Basic Operations and then Printers. 
 
Select a printer to display the documents for that printer in the right-hand window. 

 
Move a document: 
Select a document to be moved and drag it to the printer in the right-hand column that you want it 
moved to.  The document will be moved to the destination printer.  For large documents this could 
take some time. 
 
Copy a document: 
Select a document to be copied and drag it to the destination printer using the right-hand mouse 
button instead of the normal left-hand button.  When you drop the document into the destination 
printer you will be given the option of Move Here or Copy Here.  Select Copy Here and a copy of 
the document will be added to the printer.  
 
 
 
Delete a document: 
 
Open Basic Operations and then Printers. 
 
Select a printer to display the documents for that printer in the right-hand window. 

 
Select the document to be deleted. 
 
From the File menu select Delete or click the black “X “on the toolbar. 
In the Confirm Delete window verify the correct document is listed then click Delete. 
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Sending the print job to a user on a different System: 
 
From the File menu select Send. 

 
 
Send via TCP/IP to a different System i: 
 Choose a System i host name or IP address  
 Click on System i radio button 
 Fill in the known output queue and library  
 Deselect Transform to ASCII  
 Click OK. 
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Moving the print job to a different printer: 
 
From the File menu select Move. 
 

 
 
Click Browse to select a printer, and click OK. 

 
 
Click OK again to complete the process. 
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Temporarily Change the Library Search Order  
for Editing 1099 files 

 
Note:   
This procedure will change the way your current i5 session looks for the files it needs.  The i5 will look at the library 
you add before any other library.  If it finds the files it needs there it will use them without looking further.   
 
The library you add will only be in effect only as long as you are logged on.  When you log off, the Library Search 
Order will return to the way it was before. 
 
 
1.  At a command prompt enter ADDLIBLE and press F4 
 

 
 
2.  Enter the library you temporarily want to be the first one used 
 

Library = alta1099 
List Position = *First 

 
 

3.  Press Enter to save your library list and exit. 
You should get a message below the command line:  Library ALTA1099 added to library list. 

 
 
4.  Verify the library was added 

At a command prompt enter CHGLIBL and press F4 
Verify that the first library is ALTA1099. 

 
 
5.  Press F3 to exit. You can begin processing 1099 files using the files saved in the ALTA1099 library. 

1/2/2007 
 

1



 
 

Temporarily Change the Library Search Order 
 
Note to MIS:  The library search order works much as the PATH command does in DOS. 
 
At a command prompt enter ADDLIBLE and press F4 

Library = the library you want to add.  example: zlib 
List Position = First 
F3 to exit 

 
 
At a command prompt enter CHGLIBL and press F4 

Verify that the desired library is listed first. 
F3 to exit 

 
 
The changes will only be in effect as long as the user is logged on.  When the user loges off the Library Search Order 
will return to the way it was before. 
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Transfer a Report from AS400 Spool file to a Text Document 
(LDI process/iSeries Access Data Transfer) 

 
Sign on to the AS400  
 
Create your report as you would normally 
Immediately, on the command line enter:  WRKSPLF 
 

This will display a list of print jobs in the spool file for the user that is currently logged on. 
Select the report you want to transfer 
Take Option 3 Hold to hold the report 
Take Option 8 Attributes and record the following information 

File 
Job 
User 
Number (under Job) 
Number (under File) 
 

Exit the spool window. 
 

On the command line enter:  CALL CLSPL03 
Enter the information recorded from the Spool File Attributes 

Spooled file = File 
Job Name = Job 
User = User 
Number = Number (under User) 
Spooled file number = Number (under File) 
 In the field “Copy to File” always enter “REPORTS” without the quotation marks.   

This is a file in the LDI library (LDILIB) where the report will go 
 

Press Enter and the report will be copied to the Reports file. 
 

On the command line enter:  WRKSPLF  
Delete the report just placed on hold. 
You can close the AS400 program at this point if you like. 
 
Option 1 – Step-by-Step process 
On the PC Right click the desktop 
Select New… 
Select Data Transfer from AS400  (don’t confuse it with Data Transfer to AS400) 
The following window will open. 
 
Option 2 – Enter directly in Transfer Window
Windows Start menu – programs – IBM Client Access – Data Transfer from AS400 
Enter the information found on page 7 of this procedure directly into the “Data Transfer From AS/400” window



Click Next 

 
 
Click Next 

 
 
Click Browse… 
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Click the plus sign in front of LDILIB to open a list of files in the library 

 
 
Scroll down to REPORTS and click on it once to highlight it 

 
 
Click Select to add it to the Selected files and members window 
Click OK 

 
 
Click Next 
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Click Next 

 
 
Enter the path and file name where you want the report transferred to or use the Browse… button 
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Clicking the Browse… button above opens the standard Windows browser. 
Select the path, enter a file name, and click Open  

 
 
Click Next 

 
 
Click Next 
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Click Finish 

 
 
 
If you want to change anything, the various buttons take you back to previous windows 

 
 
Click the Details… button next to Output Device to display the following 
Check the box for Save transfer description if you will need to repeat the transfer, otherwise, uncheck it 

 
 
If everything is correct, click Transfer data from AS/400 
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The following will be displayed when the transfer is complete 

 
 
 
If asked to save the transfer request Click No unless you want to save it. 
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Turn Off Amber Light on the i5 
 
 
The Amber light on the i5 indicates there is a problem with the system.  Once that problem has been resolved the light 
can be turned off. 
 

1. Log on to the i5 as QSECOFR. 
 

2. Open the System Services menu by entering STRSST on the command line. 
 

3. Take Option 1 Start a Service Tool. 
 

4. Take Option 7 hardware Service manager. 
 

5. Take Option 6 Work with Services Action Log. 
 

a. Enter a date range for the log. 
b. If there are items to acknowledge press F6. 
c. Then press F10 to confirm. 
d. The amber light should go out. 

 
 



Update UFS Report Printer Defaults  
 
Sign on as System Operator user 
On Command Line: Type GO SYOPMAIN, Press Enter (to access the System Operator Main Menu) 
 

 
On Command Line . . . Type: Option 11, Press Enter 
 

 
Enter the Report ID . . . i.e. PS035E01, Press Enter   
 



 
 
At this point you can specify a printer you want the report to use, the form type, number of copies, if you 
want to put the report on hold, save spooled report, or print duplex (two-sided)… 
 
Default printer . . . To specify a specific printer for the report to use, enter the printer name. Press F4 to 
prompt for a list of available printers on your system  

 
(*OUTQ will print to Default printer of the User) 
 
Form type . . . Leave blank (recommended), or enter a specific Form name (i.e. SPEC) 
 
Number of copies . . . Defaults to 1; to change, enter number of copies to be printed every time the 
report is created 
 
Hold report . . . Select Yes to put report on hold report or No to release it for printing immediately  
 
Save spooled report . . . Select Yes to save spooled report or No to not save the spooled report. (Note: 
a Saved spool file will not appear as saved until printed) 
 



Duplex . . . Select No to print on one side only (Note: If you use the duplex option, you’re probably going 
to want to select Tumble) 
 
For one report in particular, PS035E01 – the Inbound Audit Report, you will also get the option to specify 
if you want it to break on invoice # or not. 
 

 
Break on Invoice #. . . Select Yes for a page break by Invoice # as well as by Vendor or No to print the 
report with page break by Vendor only. 
 
The option to control printer defaults is only available for UFS reports, and is not available for special form 
reports, like checks. 



Working with Files 
 
STRPDM = Programming Development Manager 
 Work with members (files) 

 
 

 
 

 



Working With AS400 Printers 
 

• Create a new AS400 Printer by copying an existing printer  
• Rename an existing AS 400 printer  
• Create a New Printer on the AS400 to replace an existing printer (same IP)  
• Assigning a printer in a user profile 
• Create NEW Remote OutQueue and Message Queue and assigning users  
• Changing Multiple Users to remote printers (from green screen)  
• Turning off separator page with remote writers  
 
Create a New AS400 Printer (New IP) by copying an existing printer  
 
Enter wrkdevd ..existing printer: 
Select the existing printer and click Copy 
Enter the new printer name and description 
Enter new IP address 
Click OK 
 
Enter wrkcfgsts *dev 
Select the new printer and Vary it On 
 
Enter wrkwtr *all 
Select the new printer and start it 
 
Add the printer to any User Profiles that will use the new printer.  
 
Rename an existing AS 400 printer  
 
Enter wrkwtr * all  
Select the new printer and stop it  
Enter wrkcfgsts *dev 
Select the new printer and Vary it Off 
 
Enter wrkdevd ..existing printer:  
Take Option 7 to rename the printer  
Enter the new printer name and description  
Change all User Profiles that were using the old name to the new printer name  
 
Create a New Printer on the AS400 to replace an existing printer (same IP)  
 
Enter wrkwtr *all  
Select the new printer and stop it  
Enter wrkcfgsts *dev  
Select the new printer and Vary it Off  
Enter wrkwtr  
Select the printer and click End  
Click OK  
Enter wrkcfgsts *dev  
Select the printer and click Vary off  
Enter wrkdevd ..existing printer;:  
Select the existing printer and click Copy  
Enter the new printer name and description  
Enter new IP address  
Click OK  
Enter wrkcfgsts *dev 
Select the new printer and Vary it On 
 
Enter wrkwtr *all 
Select the new printer and start it 
Add the printer to any User Profiles that will use the new printer 



 
 
Assigning a Printer in a User Profile  
 
Print Device: 
 
AS/400 printer (Enter wrkwtr *all and check printer Type is PRT)  
Print Device = ~printer name:? 
Output queue = *WRKSTN 
Library is blank 
 
Remote Writer: 
AS/400 remote printer (Enter wrkwtr *all and check printer Type is RMT) 
 
Print Device = *WRKSTN  
Output queue = ~printer name:? 
 
Library = QUSRSYS (or whatever library it is set up for.  
Example of an AS/400 Print Device called "netprt15" (Remote writer is different)  
 
Create NEW Remote OutQueue and Message Queue  
 
This example establishes an OutQueue NETPRT## for laser printer at IP address 10.2.5.236 that will use message 
Queue NETPRT##Q*  
Create a Message Queue 
At the command line type: CRTMSGQ - Press F4 
Name = NETPRT##Q (Printer Queue Name) 
Library = QUSRSYS 
Text Unit 3 Sandis Printer (Description) 
Press Enter or Click OK 
Look for Msg at bottom to confirm 
 
Create an Output Queue  
At the command line type: CRTOUTQ - Press F4 Output Queue = NETPRT## (Printer Name) Library = QUSRSYS 
Remote System = *INTNETADR - Press F10 (Click Advance)  
Remote Printer Queue = 'RAW'  
Click on down arrow to Page Down  
Writers to Auto Start = 1  
Queue ..........= NETPRT##Q Library = QUSRSYS  
Connection = *IP 
 
Destination = *OTHER Press ENTER Twice to continue  
Manufacturer Type and Model = *WSCST -Press Enter  
Workstation customizing object= HP4_198  
Print separator page = *NO  
Library = QGPL  
Internet Address 10.2.5.236 (TCP/IP address) or Host Table Name Page Down  
Text Description = Unit 3 Remote Printer  
Press ENTER  
Look for Msg to confirm  
 
Assigning Users (Must have *SECADM Authority)  
At the command line type: WRKUSRPRF ALUSERNAME *- Press ENTER  
Highlight all the users for that unit  
Click Change  
Press F10 = Additional Parameters  
Page Down until you see the MSGQ and Output Queue  
MSGQ = NETPRT##Q  
Output Queue = NETPRT##  
Library QUSRSYS  
Changing Multiple Users to remote printers (from green screen) 
At the command line type:WRKUSRPRF ALUSERNAME * (EX: ALKO*) 
Enter "2" for the users to change (to show field names press enter and then F11) then tab to command line 
At the command line type: PRTDEV(*WRKSTN) OUTQ(QUSRSYS/NETPRT##) 



Press enter and the action is complete, check new settings. 
 
Turning off separator page with remote writers  
When "Auto Start" is set for a remote writer it cannot be modified until writer is "END"  
At the command line type: WRKOUTQ  
Find printer and enter number "9" & press ENTER  
Type "4" to end the writer and press ENTER  
Type WRKOUTQ again, find the printer enter a "2" and make the changes.  
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